CREATING ACCESSIBLE DOCUMENTS IN MS 2007.
By
Susan A. Steffani
and
Diane E. Schmidt
California State University
AIM Grant

Table of Contents
Introduction..................................................................................................................................... 2
Template. .................................................................................................................................... 2
Headings. .................................................................................................................................... 3
Numbered Lists........................................................................................................................... 3
Tables.......................................................................................................................................... 3
Captions For Objects And Media Links. .................................................................................... 3
Special Punctuation..................................................................................................................... 3
Concise Phrasing and Style......................................................................................................... 4
Converting An Existing Syllabus Document To An Accessible Document............................... 4
STEP 1: Preparing the document for conversion....................................................................... 4
STEP 2: Locating Styles and Formatting Task Pane................................................................. 4
STEP 3: Preparing Document.................................................................................................... 6
STEP 4: Format Headings. ........................................................................................................ 7
STEP 5: Applying Headings to Your Document. ................................................................... 13
STEP 6: Viewing the Major Headings with Document Map. .................................................. 14
STEP 7: Bullets and Numbering.............................................................................................. 16
STEP 8: Creating Tables for Text in Columns.......................................................................... 16
STEP 9: Creating and Attaching a Syllabus Styles and Formatting Template for Additional Syllabi Conversions ................................................................................................................. 23
Accessible Handouts..................................................................................................................... 31
Images Accessible to Screen Readers (Pictures, Clip Art). ....................................................... 31
Captioning................................................................................................................................... 33
Documents Using Auto Shape and Drawing for Concept Maps or Flowcharts. ..................... 35
Creating Hyperlinks.................................................................................................................... 39
Accessible PowerPoint Presentations.......................................................................................... 42
Preparing a new accessible PowerPoint presentation: ........................................................... 42
Introduction.

Universal Design for Learning is an approach which focuses on creating accessible documents for all types of learners. The approach is especially helpful for learners with visual, cognitive, auditory, and mobility dysfunctions. When developing documents to create greater accessibility each type of learner must be considered. More specifically:

- **Visual.** These learners include blind, low vision, and color-blind individuals. Blind and low-vision learners will often use screen reading software (often referred to as screen readers) which requires certain kinds of punctuation and navigation formatting. Color-blind accessibility includes limited use of color for communicating information.

- **Cognitive.** These learners include learning disabled, traumatic brain injured, and other forms of impairment which affect information processing. Those with cognitive impairments may use screen reading software, but even those who do not will benefit from increased ease of navigation functionality. Concise, uncluttered, low noise document formatting increases comprehension and reduces distractions.

- **Auditory.** These learners include individuals who are deaf or hard of hearing. Documents with links to websites or require any sound as part of the communication of information must be captioned.

- **Mobility.** These learners include individuals who have restricted or no mouse or keyboard mobility or capability. These learners require navigation formatting which provide simple limited steps for locating information in the document. They may or may not be using screen reading software.

Accessible documents have a variety of formatting functions regardless of purpose:

- Templates.
- Headings.
- Numbered lists.
- Tables.
- Captions for objects and media links.
- Alt-tags for objects and images.
- Special Punctuation.
- Concise Phrasing.

**Template.**

A *Template* is a format and styles document attached to your document. Every time you open a new document, you will automatically open the “normal” template developed by Microsoft. For MS Word you can make your own document template which can include the formatting needed for accessibility. For PowerPoint you will need to choose a design template which is preset for accessibility.
**Headings.**

Whenever you develop a new section or idea in a document, you need to label it using *Headings*. This allows for screen readers to read sections of a document rather than having to read the entire document. You can also navigate within your document to different sections if you have developed Headings using the Document Map feature. It also allows for creating a Table of Contents for the document that is linked to the headings.

**Numbered Lists.**

The *Bullet/Numbering* formatting function needs to be used for all listed information. Numbered lists should be used when the list has a rank order or sequential steps. Bullets can be used for other lists.

**Tables.**

Information listed in columns should be formatted using the *Table* function. In a new document, this can be done by using the *Draw Table* command. In an existing document, the text information can be converted to a table of information by using the *Convert* command.

**Captions For Objects And Media Links.**

Media files and hyperlinks should be used only when they can illustrate or enhance a message. Images and objects should not be added to a document as decorative or gratuitous. If the media or links are clearly useful, then they must be made accessible. Visual information must be described completely using captions and audio must include a complete transcript of the text. Audio-video clips must be captioned so that the text is visible as the video is playing. In addition, hyperlinks included in the document text are confusing, complicated, and often fail to be accessible. Although faculty and students may have access to the Internet from the classroom, depending on hyperlinks is risky. Connection failures, control over fonts, noises, readability, and more are frequent problems which interfere in creating coherence and understanding. Such links should be reviewed for accessibility prior to using them to present evidence or examples.

- Video must be described completely in alternative text (Alt-Text).
- Audio must have a text transcript.
- Multimedia must be captioned.
- Links to Websites (referred to as hyperlinks) should be used only if Website is already accessible.

**Special Punctuation.**

Punctuation is an important component for maintaining coherence for both the physically and programmatically disabled learners.

- Capitalize first letter of bulleted and numbered lists, headings, and sentences. Capitalization indicates the beginning of a new phrase or thought.
Use periods at the end of each phrase/sentence. This includes headings, items in bullets/numbered. The use of periods at the end of each phrase creates visual benchmarks for ending a thought. For screen reading software, the period indicates the end of a phrase.

Do not abbreviate. Abbreviations should never be used because not only are screen readers unable to process the abbreviation, learners with visual, auditory, and cognitive impairments will not necessarily understand what the abbreviation means. Remember, spell checkers do not always catch misspelled words or abbreviations, especially in titles.

Do not use contractions. Contractions can also create word confusion.

Use acronyms only after defining them.

**Concise Phrasing and Style.**

- Remove clutter. Keep document neat and orderly.
- Avoid long quotes or paragraphs of text.
- Use an average of 5-6 words per line per bullet or numbered list, avoid wrapping text whenever possible.
- Use no more than 3 or 4 lines per bullet or numbered list whenever possible.
- Limit use of color (e.g., fonts, backgrounds). If used, do not use blue, red, and green; learners with visual or cognitive dysfunctions have more problems with these colors.
- Bolding, italicizing, and underlining does not get read by screen readers and should not be used for conveying information or emphasis.
- Avoid symbols and pictures. If pictures are necessary, they must be captioned and Alt-tagged.

**Converting An Existing Syllabus Document To An Accessible Document.**

Students with visual impairments or disabilities rely on documents being read. This is done using various screen readers. These computer applications can only read the document in its entirety unless it is developed with headings. With headings, the computer program can read the headings and the student can pick the appropriate section he/she wants read. Use the following steps to change an already written syllabus to include headings:

**STEP 1: Preparing the document for conversion.**

a. Open the document you want to convert.
b. Select the *Office Button*.
c. Select *Save As* to save the document under a new filename.
d. Select *Word Document* and type in the name of the new filename in the new dialog box.

**STEP 2: Locating Styles and Formatting Task Pane.**

a. Click on the *Home* ribbon.
b. Select *Change Styles* tab (or Alt+Cntl+Shift+S) (see Figure 1).

![Figure 1: Getting Styles Menu on Home Ribbon.](image)

- A *Styles* task pane will appear on the right hand side of screen listing all formatting currently in the document (Figure 2).

c. A *Styles* task pane will appear on the right hand side of screen listing all formatting currently in the document (Figure 2).
STEP 3: Preparing Document.

There are several ways to remove the style formatting from the document to get a fresh document. The easiest way would be to take the following steps:

a. Select all text in the document window (control A).

b. In the Styles task pane, click on Clear All. This clears all current visible formatting in the document. (Figure 3)
STEP 4: Format Headings.

You now need to format all of your headings. You can have different levels of heading. For instance, Heading 1 may be capitalized, center, and bolded. Heading 2 may be left justified and capitalized. The number of headings will depend on your document needs.

a. Make sure that no text is selected in your document. Then, to format a heading, select Heading 1 in the Styles task pane. The paragraph symbol will change to an arrowhead which allows you to open a drop down menu. Click on the arrow to see formatting menu (Figure 4).
b. Select *Modify* (Figure 5). A box will open titled *Modify Style.*
c. Now modify your formatting (Figure 6). This will most often be done by clicking on the **Format** box in the bottom left hand corner which provides options for such functions as **Font** and **Paragraph** (Figure 7).
d. To add additional heading styles, in the Home ribbon, selecting the More arrow to the left next to the Change Styles dialog/tab (or Cntl+Shift+S).
e. Select Apply Styles from the dialog box (Figure 8).
f. Name the style in the dialog box, in this case, Heading 2.
g. Select Apply (Figure 9).
STEP 5: Applying Headings to Your Document.

To change the format of text in your document, you need to apply the style from the *Styles* task pane.

a. Select the text you wish to change in the document.

b. Choose a style by placing the mouse curser on the style in the task pane. In the example below, Course Description has been highlighted and then in the *Styles* window, HEADING 2 is selected (Figure 10).

c. Left click the mouse in the *Styles* task pane. This will change the formatting of the heading. In our example, it changed Course Description to bolded (Figure 10).
d. Continue this step until you have changed all major sections of your paper so that they are identified as headings.

**STEP 6: Viewing the Major Headings with Document Map.**

a. Go to the *View* ribbon.
b. In the *Show/Hide group*, check the *Document Map* box. This will put a check mark next to the *Document Map* box. A task pane will be seen on the right hand side of your screen. If the main headings are fully accessible, they will be listed (Figure 11). Each heading in the *Document Map* is fully linked to the same heading in the text. This makes it easier for visually and cognitively impaired individuals to find a particular topic in the text without scrolling or searching the text.
Figure 11: Document is Accessible Because Headings Listed in Document Map.

c. A file WITHOUT accessible headings will look like Figure 11 in the right hand task pane once the Document Map is turned on.
STEP 7: Bullets and Numbering.

When you cleared all the formatting in the beginning, you lost all formatting for numbering and bulleted. For coherence and greater accessibility for cognitive and visual disabilities, number or bullet information based on the following criteria:

a. Use the number function for creating ordered lists where items are listed in order of importance or sequence.

b. Use the bullets function for lists of information that do not have a rank or order.

STEP 8: Creating Tables for Text in Columns.

Special attention must be given to information you have put into columns. Screen readers will have difficulty reading this information. For greater coherence and accessibility, you need to use table format. This can be done by taking the following steps:

a. Select the columnar text (text in columns) that will be in the table. Be sure the first row of the table includes labels for the columns.

b. Go to Insert ribbon. Select Table group.

c. Select Convert Text to Table (Figure 13).
d. This brings up a dialog box. You will need to identify how the text is currently separated. Your choices will be tabs, paragraphs, commas, or others. The most common will likely be tabs (Figure 14).
e. In this case you would select *Separate text at Tabs*. This function places a column for every *Tab* in the line of text and a row after every paragraph (Figure 15).
f. Notice, the number of columns reflects the number of tabs in the first line of the original table. This will likely be too many tabs. Identify the number of columns you want and input this number (Figure 16). This step must be taken after you have selected *Tabs* as your separator.
Figure 16: Number of Columns Set to Number of Columns Wanted.

g. Your document should then have the columnar text in table format (Figure 17). You may then want to adjust width of the columns.
h. You need to have titles or labels for each of the columns (called a header row). Therefore, if your table goes across pages, there will be titles on the next page.

Complete following steps:
1) With the cursor on the header row you wish to repeat (NOTE: this must be the top row of your table), a *Table Tools* tab will appear which includes a *Layout* ribbon.
2) Select the *Layout* tab to access the ribbon.
3) Select the *Data* group.
4) Then select *Repeat Header Rows* (Figure 18 and 19).

**Figure 17: Document with Columnar Information Now in Table.**

<table>
<thead>
<tr>
<th>DATE</th>
<th>TOPIC</th>
<th>READING</th>
</tr>
</thead>
<tbody>
<tr>
<td>8/24</td>
<td>REVIEW</td>
<td>Ch. 1, 4</td>
</tr>
<tr>
<td></td>
<td>Definitions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Experiencing a Language Disorder</td>
<td></td>
</tr>
<tr>
<td>8/31</td>
<td>Assessment</td>
<td>Ch. 2</td>
</tr>
<tr>
<td></td>
<td>Treatment</td>
<td>Ch. 3</td>
</tr>
<tr>
<td></td>
<td>Hierarchies</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Due - Thinking - Question #1</td>
<td></td>
</tr>
<tr>
<td>9/7</td>
<td>Prelinguistic Stage Assessment</td>
<td>Chap. 7</td>
</tr>
<tr>
<td></td>
<td>Prelinguistic Stage Intervention</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Due - Standardized Test #1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Due - Thinking - Question #1</td>
<td></td>
</tr>
<tr>
<td>9/21</td>
<td>Emerging Stage Assessment</td>
<td>Chap. 8</td>
</tr>
<tr>
<td></td>
<td>DUE - Thinking - Question #2</td>
<td></td>
</tr>
</tbody>
</table>
Figure 18: Task Panes for Repeat Header Rows.
STEP 9: Creating and Attaching a Syllabus Styles and Formatting Template for Additional Syllabi Conversions.

Once you have a syllabus formatted for accessibility, you can create a Word template for changing or creating additional syllabi with this pre-set formatting. To make a Template:


b. Select the Office Button (Figure 20).
c. Drag cursor to *Save As* but do not select or click. This will bring up a menu of selections for types of files (Figure 21).
d. Select *Word Template*. This will bring up the Save As dialog box.
e. In the left *Save In* pane, select *Trusted Templates* (Figure 22).
f. Change the *File Name* to Syllabus Template.
g. Select *Ok*.
h. This will save the *Styles* from the document to the file format *.dotx*. (Figure 14) in your *Templates* folder.
i. Open the syllabus you want to change or create. If it is an existing document, you may want to follow Steps 1-3 to clear formatting and saving as a new document. This will clean up the *Styles* window pane. It is not necessary that you do this.
j. Select the *Office Button*.
k. Select *Word Options* tab at the bottom of the dialog box (Figure 23).
1. Select Add-ins. This brings up an Add-ins dialog box. In the Manage box, pull down menu at the arrow. Select Templates (Figure 24 and 25).
Figure 24: Selecting Add-Ins.
m. Select Go. This will bring up a Templates and Add-ins dialog box.

n. In the Document Template box, select Attach. This brings up an Attach Template browser. Locate Syllabus Template 2007.dotx. This may or may not be on the screen. Select the Syllabus Template 2007.dotx file as seen in Figure 26 (this is the template you created previously in this step).
Then click on the Open tab.

Put a check in the box *Automatically update document styles* (Figure 27).
Then click on the **OK** tab. The new style template will be attached to your document. This means that the Headings are formatted as they are in your template and can be applied to your document.

### Accessible Handouts

Accessibility for handouts is not much different than for syllabi. Existing documents and new documents need to have headings, numbered lists, and tables created with the table format. You will want to follow STEPS 1-8. This will work well with handouts that are text only; however, if you have handouts that contain pictures, figures, flowcharts, concept maps, etc., you will need to use Alternative-Text, commonly referred to as Alt-Tag.

**Images Accessible to Screen Readers (Pictures, Clip Art).**

- Follow the Steps 1-3.
- Each image should be tagged using the Alternative Text function.
- Right click on the image.
- Select the **Size** tab (Figure 28). A **Size** dialog box will appear.
Figure 28: Selection of Size for Alternative Text.

e. Select the Alt-text tab.
f. In the Alt-text tab. That will open an Alternative Text box where the image can be described in detail (Figure 29).
g. Close the description box. You will not see any indication that there is an Alt-tag attached. This will be read by screen readers only.

**Captioning.**

a. Select the item needing a caption.
b. Right click on the image.
c. Select the *Insert Caption* (Figure 30). An *Insert Caption* dialog box will appear (figure 31).
Figure 30: selecting Insert Caption.

d. Type the caption. (Note this may be a different font color which can be changed later).
Documents Using Auto Shape and Drawing for Concept Maps or Flowcharts.

Objects drawn with boxes, ovals, and lines using the Autoshapes or Drawing functions cannot be read coherently by a screen reader. To keep the image intact and make it accessible do the following:

a. Create your document.
c. Go to Insert tab to access the Insert ribbon.
d. In the Text group, select the last button on the right at the bottom the group. This is the Insert Object box (Figure 32). This brings up a dialog box.

e. Select OK
Figure 32: Insert Object Button.

e. Select *Create from file*. Select *Browse*. Locate the file. Select *OK*. (Figure 33 and 34).
Figure 33: Selecting Object to be Inserted.
f. Describe the flowchart/concept map in detail in an Alt-tag by right clicking the object. This brings up a dialog box. Select Alt-text tab (Figure 35). Add description in Alt-text box.
Creating Hyperlinks

Web addresses need to be active links in the document. The default setting for MS Word is to automatically format an active link as you are typing the link. If the web address is an active link, it automatically shows up in the document in a blue font and is underlined. If this automatic format function is not enabled, then the web address will need to be activated.

If the Web address does not automatically show up as an active link in the document, do the following:

a. Type in the web address in the document.
b. Then highlight the hyperlink.
c. Right click (or use CNTL K) to open the dialog box for inserting a hyperlink. Select Hyperlink.
d. Make sure the address box shows the entire website address (see Figure 36).
e. In the Text to Display box, type a descriptive title (Figure 36).
Figure 36: Hyperlink Dialog Box.

f. Select *Screen Tips* tab. A new dialog box will open (Figure 37).

g. Type the same descriptive title again. Select *OK* to exit *Screen Tips*.

h. Then select *OK* to exit the *Hyperlink* dialog box.
Figure 37: Screen Tips Dialog Box.

i. The web address will be replaced with a descriptive title in blue font and underlined.

If the Web address automatically shows up as an active link in the document, do the following:

a. Type in the web address in the document.
b. Point to the Web address and right click (or use CNTL K) to open the dialog box. Select Edit Hyperlink.
c. In the Text to Display box, type a descriptive title.
d. Select Screen Tips tab. A new dialog box will open.
e. Type the same descriptive title again. Select OK to exit Screen Tips.
f. Then select OK to exit the Hyperlink dialog box.
g. The web address will be replaced with a descriptive title in blue font and underlined.
Accessible PowerPoint Presentations

Creating an accessible PowerPoint presentation is not much different from creating an accessible handout or syllabus. The criteria are the same but formatting commands differ and the source of the templates differs as well. For a full illustrated example of accessible PowerPoint presentations, see the module in the EnAct Library website EnAct Sonoma AIM Library website or directly at the Accessible PowerPoint website. Another source of information is the website PowerPoint Magic which includes tutorials for creating accessible PowerPoint presentations.

Accessibility criteria that are the same for all documents and described above:

• Headings.
• Numbered lists.
• Bullets.
• Tables.
• Captions for objects and media links.
• Special punctuation.
• Concise phrasing and style.

Accessibility criteria which are different for PowerPoint Presentations:

• *Slide layout*. Adopt a high contrast template. Avoid red and green backgrounds or backgrounds with graphics that overlap the text. Do not have animated or elaborate screen transitions.

• *Fonts*. These should be between in Arial or Tahoma font with 28–40 font size. Avoid red and green, or animated text.

• *Outline*. All text must be written in the *Outline* pane for it to be screen reader accessible. Any text or graphics that do not show up in the *Outline* pane cannot be read by screen reading software. Such material is inaccessible to the vision impaired unless it has been captioned or Alt tagged.

• *Notes section*. Use the Notes section to provide a complete transcript of the presentation.

• *Text Boxes*. Text boxes inserted manually are not accessible. Use *Slides* group functions to insert information.

**Preparing a new accessible PowerPoint presentation:**

a. Open a new PowerPoint document.
b. In the left task pane, select the *Outline* tab (right tab with icon) (Figure 38).
c. Select the *Design* tab to open the *Design* ribbon.
d. Select *Themes* (see Figure 39).
e. Choose a high contrast Theme with very little or no graphic designs that overlap text space. Any of these will have pre-formatted headings and fonts that are accessible.

f. Make color scheme adjustments using Background Styles, Fonts, Colors, and Effects if necessary. Dark colors with white letters or pastel colors with black letters works best. In the example, we chose Solstice Theme and changed the Colors to Concourse (Figure 40).
Figure 40: Example of Theme.

g. Adjust slide layout to improve text coherence by selecting *Home* ribbon tab
h. Under the *Slides* group, choose the *Layout* button to adjust the text boxes to preset placements (Figures 41 and 42).
Figure 41: Selecting Layout.
Figure 42: Selecting New Layout.

i. Begin typing in the text boxes and be sure anything typed shows up in the Outline pane.

j. Type a transcript of the presentation for this slide in the bottom pane where it says “Click to add notes” (Figure 43).
Reformatting an Existing PowerPoint

To prepare an accessible PowerPoint presentation from an existing PowerPoint file that was created using a blank slide and manually inserted text boxes (i.e., without a Theme):
   a. Open the existing PowerPoint document.
   b. In the left task pane, select the Outline tab (right tab with icon).
   c. If the text does not show up in the Outline pane, then the document will have to be reformatted (Figure 44).
Figure 44: Slide Prepared Without a Theme Template.

d. Select the Design tab to open the Design ribbon.
e. Select Themes.
f. Choose a high contrast Theme with very little or no graphic designs that overlap text space. Any of these will have pre-formatted headings and fonts that are accessible.
g. Make color scheme adjustments using Background Styles, Fonts, Colors, and Effects if necessary. Dark colors with white letters or pastel colors with black letters works best. In the example, we chose Solstice Theme and changed the Colors to Concourse.
h. Adjust slide layout to improve text coherence by selecting Home ribbon tab
i. Under the Slides group, choose the Layout button to adjust the text boxes to preset placements.
j. Each slide where the text does not show up in the Outline pane will have to be replaced.
k. Insert a new slide after the first slide where the text is not visible in the Outline pane.
l. Copy the text from the text box in the old slide and paste it into the text area in the new slide. Repeat this until all the text is placed in the new slide
m. Copy any notes in the Notes pane.
n. Delete the old slide.
Creating a Table of Contents for HTML (for uploading documents to Websites).

If the document is to be posted on a common Website, then the document needs to be saved as an HTML file as Web Page, Filtered. The accessibility features such as Document Map are functional only if the document is shared as a document file. To create easier navigation in an HTML file, create a Table of Contents prior to saving the file as a web page. This will create links between the Table of Contents listings and the document.

a. Open the final draft of the document. Place curser at the point you want the Table of Contents located.
b. Select the Reference ribbon.
c. Select Table of Contents in the Table of Contents group.
d. Select the style (Automatic Table 1 or Automatic Table 2). You may also select Insert Table of Contents to format your own Table of Contents format (Figure 45).
e. If you chose your own format, be sure the Use hyperlinks instead of page numbers box is check (this is the default).
f. To save the document as an html, select the Office Button, point curser to Save As, and select Other Formats. This will open a Save As dialog box. In the Save As Type box, select Webpage, Filtered, and select Save.

Figure 45: Table of Contents Menu.